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What Bentley StormCAD version do | have?

StormCAD not open:

Using Window Explorer go to where StormCAD is installed. Look for StormCADS8 and search there
for the Readme.pdf file. Open Readme.pdf.

21 Bentley

Bentley StormCAD V8i
SELECTseries 5 Readme

< Version of StormCAD installed.

This Read ins the following information:

“What's New™
s T

StormCAD open:

From the MicroStation menu bar Click the following: = StormCAD - Help = About StormCAD

27 Siemon Company Drive) Sune 200
Watertown, CT 06795 USA

N, Quick Start Lessons
3 Check for SELECT Updates

@ Bentley Institute Traning
£4 Bentley Professional Services
@& Bentley SELECT Support

@e Bentley Communities
73 Bentley.com
+s About StormCAD

Instructions that follow are for StormCAD SS5 with MicroStation SS3



Section 1 Getting Started

Easy Storm Sewer Design and Modeling

StormCAD provides comprehensive modeling for the design and analysis of storm sewer systems.
StormCAD is FEMA-approved and provides calculations for catchment runoff, gutters, inlets,
junctions, pipe networks, and outfalls, and its intuitive interface makes the design and analysis of

storm sewer systems easier.
StormCAD software is approved by the Departments Hydraulics and Drainage Unit to use for

roadway storm sewer design.

It is the designer’s responsibility to adhere to the CTDOT Drainage Manual and
CTDOT Hydraulic & Drainage Directions.

On your desktop or under the Start = All Programs = Bentley = StormCAD V8i are two
StormCAD V8i programs. StormCAD V8i for MicroStation V8i (preferred use) or StormCAD V8i,
both are standalone programs, no need to go through Accounting.

| Bentley
www.bentley.com

| DgnIndex Service Hallock, Gabriele
| i-model ODEBC Driver for Windows 7
| InRoads Group V8i (SELECTseries 2) Documents
| InRoads Group V8i (SELECTseries 3)
| MicroStation V8i (SELECTseries 3) Pictures
| ProjectWise V8i (SELECTseries 4) i
. Music
| StormCAD V8i

DESK TOP

'5@ Integrate StormCAD with AutoCA|

E License Management Tool

g Municipal License Administrator

k@ StormCAD V8i for MicroStation V.

Ed StormCAD vsi W INTEGRATED 1!
Bluebeam Software . PREFERRED

Computer

Control Panel

Games
Google Earth
HEC
Intel

—

INTEGRATED SCHEMATIC
PREFERRED

4 Back

- Start 2 All Programs >
b~ \/ Sl

Note: Before starting StormCAD, the designer should lay out the drainage systems in the
drainage MicroStation file (HW_MST_1234 1234 Drainage_MDL.dgn) to reference into the


http://www.ct.gov/dot/cwp/view.asp?a=3200&q=260116&dotPNavCtr=|

StormCAD MicroStation files. The designer should also calculate the Time of Concentration (T¢)
and drainage areas. Each System will have its own MicroStation StormCAD file. StormCAD
numbers each item but allows for the designer to add notes; it is helpful to have a sketch /
schematic of the individual system with the necessary information such as: areas, elevations,
lengths and slopes.

IMPORTANT GUIDELINES FOR USING STORMCAD V81 FOR MICROSTATION

DO NOT open other MicroStation files in the Project X-Drive container while in StormCAD V8i.
DO NOT open the newly created StormCAD VS8i file through Accounting.

DO NOT open MicroStation through Accounting and then add StormCAD V8i as a MDL.

DO NOT use the project design file(s) as your drainage design file while in StormCAD V8i.

DO follow the CTDOT MicroStation V8i Guide for Highway Designers.

DO enter MicroStation through Accounting as normal and reference the StormCAD V8i
MicroStation file in to your project design file(s).



1.1  Starting StormCAD VS8i Integrated with MicroStation

1.1.1 Use the Correct MicroStation User Configuration File

You will open StormCAD V8i for MicroStation as a standalone (not opening through Accounting)
either from your desktop or from Start. Before you start up StormCAD it is necessary that you
copy the latest CTDOT user configuration file for StormCAD to your computer.

A. Using Windows Explorer copy the file:
W:/Workspace/StormCAD_RSC/stormcad.ucf

B. Paste to C:/Bentley_V8i/Workspace/Users

F
@QTI ¢ Computer » VB Workspaces - SHIDGS1E (W:) » Worspace » StormCAD_RSC
————————————————————
Organize - Burn Mew folder

- Eavorites Mame Date mo
Bl Desktop [ StormCAD.ucf 22770
@ Downloads J aestad>eedd.dgn 204 201
= Recent Places = CTDOT_Rainfall_Table.xmil 4713720

¥ @U' . » Computer » OS5Disk (C:) » Bentley VBi » WorkSpalle » Users

Organize = Include in library « share with - Bum folder

I Favorites (2 civvil _training.ucf

Bl Desktop [ examples.uct
8 Downleads [ geo_exarmple_d
| Recent Places [ geo_exarnple_digogs.uc
[ msgeo.ucf

w4 Libraries (B Msgec_mapfingshing.uct

awn.ucf
™ Computer R StormCADwcf

&, 0sDisk (C:) /8 sue.ucf
s Data (D:) [ untitled.ucf




1.1.2 Start StormCAD & Create MicroStation File

A.

C.

D.

To open StormCAD double click the StormCAD V8i for MicroStation V8i icon located on
your desktop (or click on START > All Programs > Bentley > StormCAD > StormCAD V8i for
MicroStation V8i)

Change the MicroStation Interface to StormCAD as shown below:

MicroStation Interface

 pen | User: | StormCAD
Project: istorrncad

Options

Interface: [de#ault

In the MicroStation File Manager box, select your X-drive project folder > Highways >
_Eng_Data_/Drainage/ and select (click) the New File icon as shown:

File Open - X\999_Student01\Highways'_Eng_Data\Drainage\, s
Lookin: | Drainage - @F m%
= Name . Date modified
o No items match your search.
Recent Places

¥

In the New file box, to select the seed file click on Browse and go to:
W:\Workspace\StormCAD_RSC\HaestadSeed2d.dgn and click Open. Itis important to use
this seed file. Our CTDOT seed files have custom properties attached to it that will not
work with StormCAD.

Select Seed File - W:HWnrksEacERStormCAD_HSC\ >
Lookin: |, StomCAD_RSC - O
== % HaestadSeed2d.dgn ,
ele S
Recent Places




E. Type in the file name using file naming conventions in Appendix C of the
CTDOT DDE_Guide, example: HW_MST_1234_1234_StormCAD_Sys-01.dgn, select the file
and click Open. StormCAD files reside in the \Highways\_Eng_Data\Drainage folder.

File Open - XA\999_Student01\Highways\_Eng_Data\Drainagel

<

Lookin: |, Drainage

L]

P
T Mame

G T o

NE®

kel (/2 HW_MST 1234_1234_StormCAD_Sys-01.dgn

Recent Places

'MNMN\'\'\IM

Computer
1 m | ¢
“ T T
: File name: HW_MST_1234_1234_StormCAD_Sys-01dan ~ | Open |
Metwork
Files of type: [CAD Fies (*dgn;” dwg:" dd) ~| Cancel
[C]Open as read-only Options

F. After the MicroStation file is opened, reference in files as needed. Make sure scales are
correct (use measure tool) and turn off Levels as needed. Save Settings.

HW_MST_1234_1234 StormCAD_Sys-01.dgn [2D - V8 DGN] - MicroStation V8i (SELECTseri

ABANABT AR @ | peteu

- D 0 ¥|== 0 - E 0 - Q o - @I o - 1 m - >
. ¥ * X w View 1, Default z
# Tasks - Br@is~lA =4 4 i @
| P I ava# R_HH r" fﬂ B8 rx‘i : ) References (3 of3unique,3displayed{
[N 1) L9 oo
j ﬂ-"sﬁf-ﬂ »E?rf_ﬁ--_ﬁrﬁ Qs \ ll 1[ Tools Settings
N Drawing v ll 'll E_E: v E Ve . D &2 .. :>
X Drawing Composition b4 : 1l Slot Logical  File Name Model
4 Terrain Model b | | seevauby 1 dsgn HW_MST... 3D Desige”
& StormCAD Layout v : 1 H 2 geo HW_MST.. 3D Design
= StormCAD Layout Other - Storm ¥ | ..‘°|‘ g 3 s SV_D4.0.. 3D Desig
L o H
@ StormCAD Layout Other - Pressure W e .
= 1 Reference Attachment Se-ttings‘.. ]
[ StormCAD Component... &s == A * .
3 ke File Name:
5 O Attach New v “.1" - gy SURVEY OR DESIGN FILE >
& W Scenarios v o Model: (3D Design =
@ E Elemd et 1 Il Logical Name| SURVEY OR DESIGN >
@ R Com N Description: | 3D Design Seed ->
Jll.lﬁjllll'll/lll
:[} T Activé L0m _ine iyl 2 |alasn | >
Synchronize View: | Volume Only e | >
CEerse=—t-aoT Y | 0.0000 Toggles
- - (1.1 q | #
: Nostod Attachmens: Displey Overrids Me uf@>«@e@@ 4
%9 D Check for SELECT Upds e -
New Level Display: Vanable ¥ | Georeferenced: |N Create [v] OFF
2 print Preparation Name: [Drawing >
] Cancel_| %



http://www.ct.gov/dot/lib/dot/documents/deng/CTDOT_DDE_Guide.pdf

Section 2 Create new StormCAD Project

After creating the MicroStation file using the Haestad seed file, the StormCAD project files,
defaults and properties need to be established.

If this is the first time you are using StormCAD, we suggest you open the help menu, within
the MicroStation Menu bar click on StormCAD - Help - Quick Start Lessons.

<Micrﬂ513ﬁun Wai (SELECTseries 3)

iities  Worgpace Window | Stom elp

@ || P

Edit
* 0 X Analysis
Components

Wiew

...... : ﬂ'|E

B Viewl,

Tools

Beport
Help

b . . . . . .

¢ StormCAD Help
?Ig.nd{' Start Lessons

F3 Check for SELECT Updates

\h//\\//\...

o[y 1'-@, gy Ingtitutes] rmiging

Use this workflow along with the Quick Start lessons to work your project / system
scenarios or to learn using StormCAD.

Also, there is help available on the Bentley Learn Server. Please contact Samantha Scharpf
of AEC Applications (Samantha.Scharpf@ct.gov) for a learning path of StormCAD V8i.

The user should be aware that the CTDOT workspace is not available within StormCAD V8i
with MicroStation. This is a standalone application.


mailto:Samantha.Scharpf@ct.gov

2.1  Create Project Files

A. Within MicroStation menu bar, click on StormCAD - Project > Seed - New from Seed.

HW_MST_ 1234 1234 StormCAD_Sys-01.dgn [2D - V8 DGN] - MicroStation V8i (SELECTseries 3)

: File Edit Element Setings Tools Utiities Workspace Window | StormCAD | Help

WBANBIBR S - oo

v | [ Project b2 Atiach New..

4 Terrain Model

Edit ¥ (23 Attach Exsting...

Tasks viX - =
i B View 1, Default Analysis ¥ () Save Attached As
& Tasks TN B @i v A ] components » o Detach
1 O@ &G - View b

L RAPTACE. FIRTP P o ) oot
N Drawing v Report | Egort
% Drawing Composition Help ¥ Seed

Q StormCAD Layout
£ stormCAD Layout Other - Storm

© StormCAD Layout Other - Pressure

v

v

Repaository Me

Save Symbology to DGN

@ Project Properties

L StormCAD Component... 15 == #

B. The New from Seed dialog box opens, browse to the StormCAD Resource directory
and select the StormCAD seed-file:

W:\Workspace\StormCAD_RSC\StormCAD_CTDOT_ProjectFile_Seed.sews. This will
start your StormCAD project with the defaults and settings required. The designer

has to ensure the defaults and settings comply with the Drainage Manual for their
project. StormCAD will create the files needed, you will see some screens pop-in and
—out. Wait until StormCAD completed the start up.

_
P& New from Seed

|
@©-|| « ENG Workspaces - DOT-SDCENGO7V (W:) » Workspace b StormCAD_RSC ~ |43 || Search stormcaD_RSC P ]
S
Organize ~ New folder =~ O @

, 5 DGS CSurveys (DOT-SDCENGOLV) (F:) - q 5 STO,mCAD_pmjedF“ejeed.SeWSD

1 SP RV NG 0000000075777 70000000004
[> = ENG Workspaces - DOT-SDCENGO7V (W:) ‘E‘
» = CTDOT_Projects (DOT-SDCENGO7V) (X:) i

> G! Netwaork
> 8 Control Panel

File name: StormCAD_ProjectFile_Seed.sews - ISeed Files (*.sews, *sts)

)

Corn ] [t

10



C. StormCAD created the files and stores those in a temporary folder. The designer has to
save all files to the project folder. Within MicroStation menu bar, click on StormCAD >
Project = Save Attached As. ..

Qicros,tatmn V8i (SELECTseries 3) )
ools Utilities Workspace Window StormCA[T)\ Help
e - [Defauu v] |:| Project %_li? Attach New. ..
v 1 X Edit ExiSTng...
B View 1, Default (<defe  Analysis ) Save Attached As...
Lv@ e~ A% 2 Components @ e
WView
Tools 4 SHE g
Report N Export >
< v Help » Seed »
z i &) Project Properties... s

D. The “Save As...” dialog box opens, type in a logical file name for your system, make sure
you specify the folder where the files are to be saved/stored (see below). And click “Save”.

I Save As [ﬁ 1

@Ov|. Your Project Folder » Highways » _Eng_Data » Drainage v|+,|| Search Drainage ol

Organize ~ New folder £ o~ 9

> | Geotech

> | Highway_Ops

4 | Highways
> L. _All_Other_Data
4 | _Eng_Data

| . Drainage

[

| InRoads

| _Special_Provisions gl

File name; StormCAD_1234 1234 Sys-01.stsw -

Save as type: | Bentley StormCAD V8i (SELECTseries 5) Project File (*.stsw) VI

 —

11



E. In Windows Explorer you can see the files created by StormCAD in the file folder you
specified. Close Windows Explorer.

@". =« Highways » _Eng_Data » Drainage "J’TH Search Drainage

anize * Burn New folder gE(~| O
StormCAD file you saved

i (/& StormCAD_1234 1234 Sys-OLstsw )

=+ DGS HWYS (DOT-SDCENGO1Y) (P)

= GROUPS (\SDCDBS60) (S1) StormCAD_1234_1234_Sys-01.stsw.01.bak

& TRU Maps (T) StormCAD_l234_1234_5y5—01.5tw€f&%wh

& HallockGAS (\SDCDBS60) (U:) StormCAD_1234 12¥m-ﬁt‘s¢‘§wprofiles.dwh.m.bak
& ENG Workspaces - DOT-SDCENGO7V (W) | StomeARYERT1234 Sys-0Lstswasqlite

= CTDOT_Projects (DOT-SDCENGO7V) (X3) S‘Eﬁ:‘rmCAD_l234_1234_Sy5—Ul.stsw.sqlite.[]l.bak

,

MNetwork

= Control Panel

2.2  Set Project Properties & Options

A. From the MicroStation menu bar select StormCAD - Project = Project Properties. The
Project Properties dialog box lets you enter project-specific information to help identify the
project. Project properties are stored with the project files. Click OK.

Project Properties Li—hj

Title: Project Mumber and Title
File Name: PROJECT FILE & FOLDER YOU SPECIFIED
Engineer: Your Name
Company: Your Unit
Date: 11/18/2015 E+
Motes:
System Information -
Station to Station
Drainage Area
ETC.
0K Cancel ] [ Help l
—

12



B. Select Options from the StormCAD Components & Tools task menu. Click on the Drawing
Tab and select for Drawing mode: Scaled or Schematic.

L0 Ve V6 V5. . . 1 T T T S
[ StormCAD Component... is = m & /z
(£) Q Save Attached As »
= W Scenarios » i i
‘ Options 2
@ E Element Symbalogy ¥ :
& Rl Compute Center , | Global | Proiect| Drawing | Units | Labeling | ProiectWise |
|'E3 T om I Drawing Scale P
ons L]
| ,& oy Drawing mode: |Scaled )
@ A Default DMH Constraints... *
{3 S Scenario Summary » Plot scale factor 1in =: 40.0 P)
9 D\ Check for SELECT Updates ' ) ) >
g Annaotation Multipliers >
& pri i v
\%é Symbol Size Multiplier 1.000 >
4 \NVWWW\/\/\/\/\/\/\V’QO’\/\/\/\/O

2.3  Set Project Defaults & Import Libraries

A. Next the Default Design Constraints are set for the project. From the StormCAD
Components & Tools task click and hold Default Design Constraints, select Default Design

Constraints.
Va Ve Va Ve VA A VaaaTa e
2 StormCAD Layout -
[Z5 StormCAD Components & Tools &x = s &
[ Q Attach New 3
W Scenarios »
[& E|Element Symbology 3
@ R| Compute Center 3
;‘[}‘, T | Active Topology Selection »

1 Default Design Constraints...
[E 5| Scenario Summary

% D Check for SELECT Updates (4 2 stormData..
G 3 Global Storm Events...

AVAAAAVAVAVAVAVal o a0 'av e "aVaVaVaVaVaVaV
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B. Set/Check the default design constraints according to the CTDOT Drainage Manual. Close.

¢ Default Design Constraints

Gravity Fipe | Node |In|e¢

Default Constraints

Velocity | Cover | Slope

Slope Constraints Type:

Slope (Minimum):

Slope (Maximum):

Simple
0.005

0.100

Set Default Design
Constraints to CT DOT
Drainage Manual  [nbero e | St

Diesign?

int Type:

Percentage Full:

hold-down the left mouse button and select Conduit Catalog... .

(C:\ProgramData\Bentley\StormCAD\8\Libraries\Conduits Library.xml => default)

C.
D. Click on the book icon i

box check on the Conduit Library.xml.
E.

Import the Conduit Catalog, from the StormCAD Components & Tools tasks left-click and

and select Import from Library. In the Engineering Libraries

Click on Select. StormCAD will import all conduits. One can also expand the folder and

select all ‘Circular — Concrete’ pipes or just select a few as needed for the project. Close.

d Conduit Catalog

2

3 O SR AMAB AR BN NN |

i 3 Label C¢
| & stormCAD Component... == a | |
(3@l Attach New

& W Scenanocs

i 1'0-: )

| Condit [ Library | Not
Browse Engineering Libsary™ 'F\
Synchronize fr(:(l_ brary

= & Engina\g Libraries
bync‘nron‘zel) Library

| ——A
@ E Element Symbology
(8 R Compute Center

o Ti Active Topology Selection

Import from Libra
Export to Library

- k- X,
(=g duit Catalogs

= { Conduits Library.xml
Connect to Library VI Box

@ f1 Defaut

q

§3 S| Scenario Summary
%3 D) Check for SELECT Updates

2 Storm

& print Preparation 3 Global Storm Events...

4

2 Conduit Catalog.

& 7 Gutter Catalog..

NNV VNV NNV VNV AN NV /\./\/\/\/\uS

V& Ellipse

3
+- VI Circle
¥
s

VI Pipe-Arch
[+ |44 Conduits Library - Metric xml

e )

DX

ﬂ Conduit Catalog 2{
AXxEBme- e Conduit |Librz-1ryr | Notes| <
Label ConduitS.. | Conduit Shape \)/
€llBox- Concrste Box (| Conduit Shape: [circle Y

VEP PV oW 0boto00000000000007
dllCircle - Corugated H... Circle | A >
dll Circle - Corugated H... Circle | ] ] o
dlCircIe - Aluminum Circle J Avaiable _Ins»de Manning's | Kutter's Darcy-Wes A

. . Label for Diameter e

&l Circle - CMP Circle | BT (in) n n wm <
dll Circle - Concrete Circle | < >
dllcircle - PVC Circle [ 4 15 inch 15.0 0.013 0.013 D.I;f
4l Circle - Steel Circle ! 5 18 inch 18.0 0.013| 0.013 0y
&l Circle ; Vitrified Clay ., Cirgle 1 P

> P60 PCEPOTOONONOYYP &V

14



http://www.ct.gov/dot/cwp/view.asp?a=3200&q=260116&dotPNavCtr=|#40139

F. The CTDOT Inlets.xml| Catalog is already loaded. To see all available inlets go to the
StormCAD Components & Tools tasks left-click and hold-down the left mouse button click
on Inlet Catalog... .

G. The Inlet Catalog box opens. All CTDOT catch basins are loaded.

& Inlet Catalog | (B | -
AXBm3 & Inlet | Design | Library | Notes|

Label General

nlet Type: |Combination -

Combination Type C Double Grate - Type | - Grate T
Combination Type C Double Grate - Type |- Grate T
Combination Type C Double Grate - Type |- Grate T tructure Length: 40 ft
Combination Type C Double Grate - Type Il - Grate 1
Combination Type C Double Grate - Type Il - Grate 1

Combination Type C Double Grate - Type Il - Grate 1 ALL CT_DOT TYPE"C” &
Combination Type C Double Grate - Type Il - Grate 1 “"C-L” CATCH BASINS

tructure Width: 44 ft

Combination Type C Single Grate - Grate Type A-C ft
Combination Type C Single Grate - Grate Type A - Local Depression: 20 i
Combination Type C Single Grate - Grate Type A -

Combination Type C Single Grate - Grate Type B - Depression Width: 512 in

Combination Type C Single Grate - Grate Type B -
Combination Type C Single Grate - Grate Type B -
Ditch Lawn Drain Throat Angle: 0.00 degrees
Ditch Type C-G

Generic Default 100%
Grate Type C-L Double Grate - Type | - Grate Type ¢ Grate Type: [p_5{| mm (P-1-7/8") vl
Grate Type C-L Double Grate - Type | - Grate Type E
Grate Type C-L Double Grate - Type Il - Grate Type.
Grate Type C-L Double Grate - Type Il - Grate Type Default Grate Length: 3.0 ft
Grate Type C-L Single Grate - Grate Type A
Grate Type C-L Single Grate - Grate Type B

Throat Type: Vertical v

b B v I T = e v |

Grate

Grate Width: 32 ft

Close l l Help

1]

H. The CT_DOT_Inlet.xml can be found at:
W:\Workspace\StormCAD_RSC\CTDOT_Inlet.xml

I.  Close the Inlet Catalog.

J.  Save the project again. Click on StormCAD in the MicroStation menu, click on Project -2
Save Attached As..., in the “Save As” dialog box select the file name for your system and
click “Save”. The message “file name” already exists. Do you want to replace it. Click “Yes”.

15



2.4

The last piece of information needed is the rainfall data.

Defining Storm Events

The Department’s Hydraulics and Drainage Unit advises the designer to use the NOAA Atlas 14
data, which can be accessed through the NOAA Precipitation Frequency Data Server — PFDS in
conjunction with the CTDOT Drainage Manual.

NOAA ATLAS 14 POINT PRECIPITATION FREQUENCY ESTIMATES: CT

WWW.NWS.N0aa.gov

o~ NOAA's National Weather Service AT,
NoOAR » - . 3 :- s
V Hydrometeorological Design Studies e

General Info
Homepage
Current Projects
FAQ

Precipitation Frequency Data Server (PE 3)

search [N © nws @ aunoas BN

NOAA ATLAS 14 POINT PRECIPITATION FREQUENCY ESTIMATES: CT

DATA DESCRIPTION

Glossary Data type: [precipitation intensity V| Units: [english \/| Time series type: [partial duration v
Precipitation
Frequency (PF) SELECTLOCATION
PF Data Server 1. Manually:
a) Enter location (decimal degrees, use "-" for S and W): latitude: ‘ longitude: ‘ | \ submit |
b) Select station (click here for a list of stations used in frequency analysis for CT): |select station v
2. Use map:
PF Documents 3 ) ~4
2y . MouR
Probable Maximum < 2 > Simsbury Wind:
indsor » 2
Pf;:}»&g:“(:x:) »\; .Soulh Windsor £ a) Select location
> 3 o 4 ; (move crosshair or double click)
i+ | ¥ Bloomfield ’ _ B
Miscellaneous Cangfd + : il & ® S b) Click on station icon
Publications { & ! o { 1 ™~ 3
AEP Storm Analysis :) o A 55 W & 4 . ’ (¥ show stations on map)
Record ; © G/ o i
Precipitation 4 L4
it 1 adly Manchester
4 = Bolton
Haﬁ}efd East Hartford 554 s
Contact Us j jesthianioid @ @ 4
Inquiries & Ll \
-19:"Q J ol c
( @D, £ V 4 4
j@ / ) 175) 7
T Newington [ @ LOCATION INFORMATION:
/ Glastonbury P Name: Hartford, Connecticut, US*
@ J Latitude: 41.7635°
& O -~ r Longitude: -72.6343°
b ) Z New Britain Rocky Hill @) ! 4 ! f@ Elevation: 70 ft*
A A \ N > 1
(i : 2
o, Uy FANO) | Marlborough \
9 / Berlin ., Q) I - i ‘/ . N
7 4 1 4 / b
{ @ f / ) I}
Gosal #(60) & \O) P it Vi SR o I
gieon /) 7 CrOMWE lap data @2015 Google  2km L1 | Terms of Use | Report 2 map error || * SOUTCE: Google Maps

POINT PRECIPITATION FREQUENCY (PF) ESTIMATES

WITH 90% CONFIDENCE INTERVALS AND SUPPLEMENTARY INFORMATION
NOAA Atlas 14, Volume 10, Version 2

®100% ~

|

Follow the directions on the NOAA Atlas 14 screen and directions given by CTDOT Hydraulics &
Drainage unit on how to develop the Point Precipitation Frequency (PF) Estimates.

The precipitation frequency estimates can be downloaded in CSV-format and opened with Excel.
See an example of the PF estimate on the next page.
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http://hdsc.nws.noaa.gov/hdsc/pfds/pfds_map_cont.html?bkmrk=in

The Location Information for the example is: Hartford, CT, US; Latitude: 41.7635°; Longitude: -
72.6843°; Elevation: 70 ft.

PF tabular PF graphical Supplementary information z
| PDS-based precipitation frequency estimates with 90% confidence intervals (in inche{
Average recurrence interval (years
Duration 9 y )
1 I 2 I 5 I 10 | 25 I 50 | 100 I 200
5_min 4.M 4.36 6.26 7.42 9.1 10.2 1.5 13.0
(2.16-5.08) (3.83-6.17) (4.91-7.97) (5.78-9.50) (B79-12.1) (7.55-14.1) (8.20-18.4) (8.78-19.1)
10-min 2.84 3.44 4.43 5.26 6.38 7.25 8.13 9.22
(2.24-3.50) (2.71-4.37) (3.48-555) (4.10-6.73) (4.831-8.58) (5.35-0.58) (5.81-11.6) (6.22-13.5) D
15.min 2.23 2.70 3.48 412 5.01 5.69 6.38 T7.23
(1.76-2.82) (2.13-3.43) (2.73-4.43) (3.21-5.28) (3T7T-673) (4.20-7.82) (4.56-8.12) (4.88-10.8)
30.min 1.49 1.82 2.34 2.78 3.38 3.85 4.31 4.39 >
(1.18-1.59) (1.43-2.30) (1.84-2.98) (2.17-3.56) (2.55-4.55) (2.84-5.20) (3.08-6.1T) (3.30-7.17) P
60-mi 0.938 1.14 1.47 1.75 213 2.42 2.72 J.08
-min (0.739-1.18) || (D.888-1.45) (1.16-1.88) (1.36-2.24) {1.61-2.86) {1.79-3.33) (1.94-3.28) (2.08-4.52) D
2-hr 0.609 0.738 0.948 1.12 1.36 1.55 1.73 1.99
) (D.483-0.766) || (0.584-0.820) || (0.748-1.20) || (0.881-1.43) (1.03-1.53) {(1.15-2.12) (1.25-2.45) {1.35-2.90)
1h 0.468 0.566 0.727 0.861 1.05 1.19 1.33 1.53 b
-nr (D.372-0.586) || (0.450-0.711) || (0.576-0.816) || (0.678-1.08) | (0.786-140) || (D.886-1.63) || (0.865-1.80) (1.04-2.23) P
6-hr 0.293 0.356 0.459 0.545 0.662 0.753 0.844 0.978
) (0.235-0.365) || (0.285-0.444) || (0.366-0575) || (0.432-0688) || (0.508-0.850) || (0.566-1.03) || (@E17-1.21) || (D.667-1.42) b
12.h 0.177 0.217 0.282 0.337 0.412 0.469 0.527 0.615
-nr (D.143-0.218) || (0.175-0.268) || (0.227-0.351) || (0.268-0.421) || (0.318-0.544) || (0.355-D.637) || (0.388-0.750) || (0.420-0.884)
24_hr 0.103 0.129 0.171 0.205 0.253 0.290 0.327 0.386 >
- (0.084-0.127) || (0.104-0.159) || (0.138-0.211) || (0.165-0.255) || (0.197-0.33%) || (0.229-D.383) || (0.243-0.455) || (0.265-0.552
2.da 0.058 0.074 0.100 0.121 0.151 0.173 0.196 0.237
y (D.045-0.071) || (0.080-0.091) || (0.081-0.123) || (0.098-0.150) || (0.118-0.198) || (0.134-D.235) || (0.148-0.251) || (0.163-0.337)
3 da 0.042 0.054 0.073 0.089 0.110 0.127 0.143 0.174 b
-day (0.035-0.051) || (0.044-0.066) || (0.050-0.089) || (0.072-0.108) || (0.087-0.145) || (0.098-D.172) || (0.109-0.205) || (0.120-0.247)
Ada 0.034 0.043 0.058 0.071 0.088 0.101 0.115 0.139
¥ (0.025-0.041) || (0.035-0.052) || (0.045-0.071) (0.053-0.087) || (0.070-0.11%) || (0.079-D137) || (0.087-0.163) || (0.095-0.197)
7.da 0.023 0.029 0.038 0.046 0.057 0.066 0.074 0.089
-day (0.015-0.028) || (0.024-0.025) || (0.032-0.046) || (0.038-0.058) || (0.045-0.074) || (0.051-D.088) || (0.056-0.105) || (0.062-0.125)
10.da 0.019 0.023 0.030 0.036 0.044 0.050 0.056 0.067 >
-aay (0.015-0.022) || (0.015-0.027) || (0.025-0.038) (0.029-0.043) || (0.035-0.057) || (0.039-D.066) || (0.043-0.079) || (0.045-0.094)
20-da 0.013 0.016 0.019 0.022 0.027 0.030 0.033 0.038
Y || wo11-0.016) || (@013-0.m18) || ©016-0.023) || wo1s-0027) || . E|21 D 034) || (0.023-0.038) || (0.025-0. D45) (0.027-0.053)
AV v v v VS S AV vl mi vl v v vl vl v e =~

The data you see in the PF tabular format will be used for StormCAD to create a new User Defined

IDF table specific to your project location.
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A. In StormCAD within the StormCAD Components & Tools task, click on Storm Data...

B. In the Storm Data box click the New icon ||'|_']_,[ and select User Defined IDF Table. A blank
IDF table is created (User Defined IDF Table -1).

Stom Event Input |J|:H-_|,r Wnta

Elﬂﬁfl| User Defined | Table (A~ X| T X
E User Defined IDF Table - 1

=1 Hydro-35 Duration
: (hours)
-2 IDF Table Equation

-{=h |DF Curve Egquation

-{=1 IDF Polynomial Log Equation
- UK Standard

™

AVAVAVAV AN

i

C. Right-click on User Defined IDF Table — 1 and click Rename. Rename your table, example
Hartford. Or Project No.

D. Click on the Notes Tab. Add notes pertaining to the project: location, latitude, longitude
and elevation from the NOAA Atlas 14 data. (This will help you and others to duplicate the
data if needed).

(7] Storm Data >
Ij" X m |'5'1 |- |5tnn'n Event Input | Ublﬁl‘_fl Motes
- User Defined IDF Table =
{7 User Defined IDF Table - Haford  /{| LOCATION INFORMATION: ™\
A= Hydro-35 Mame: Hartford, Connecticut, US™
) |DF Table Equation sttude: 417635° >
--{h |DF Curve Equation Longitude: -72 63437 >
--{=) |DF Polynomial Log Equation Elevation: 70 ft
~5 UK Standard test StormCAD 14 >
N Nov-2015 _/ >
z’VVW\/W\/W\/\/\/\/\/\/\/\/Q
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E. Select the Storm Event Input Tab and click on the down arrow for Add/Remove Return
Periods. Select Add Range...

7] Starm Data

A-XmR m e

El{ﬁ User Defined 1DF Table

Storm Event Input

A &TE ~

y | Motes |

E lUser Defined IDF Table - Hartford

AVAVAVAVAVAVAVAVATAYS

Add Return Period

Add Range...

|

F. The Add Multiple Return Periods box opens. Enter the return period (year) needed for
your project. (2, 10, 25, 50 and 100 years). Click OK when all period years are entered.

G.

-
7] Add Multiple Return Periods

=)

Enter the new retum perods:

Return Period (Year)
2
10
-;—; input 2 >
; of|| tabinput
10 tab >>>
| ok || cancel |

Click on the down arrow for Add/Remove Durations. Select Add Range...

T
7] Storm Data

P

A-Xm2 o e

Starm Event Input | |

otes |

E-=h User Defined IDF Table

AVAVAVAVAVAVAVAVAVAVA

Ev

[=E
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Add Duration
n/h)
Add Range...

25 Year
(in/h)

Year

100 Year
{in/h)

50 Year
{in/h)



Formatting..., change Unit: from hours to

The Add Multiple Durations box opens. Right-Click on Duration (hours), click on Units and

min, click OK.

I. Enter the Duration (min) needed for your project. (5, 10, 15, 30, 60, 120, 180). Click OK

when all durations needed are entered.

M . " = =
Add Multiple Durations > Add Multiple Durations -
Enter the new durations: > Erter the new durations:
Duration > Duration
(hours) {min)
5,000 > 5000 1 -
o] ¢ o000 input 5 > tab
Add Multiple Durations @ ool > input 10>
Enter the new durations: > 50.000 tab .
60,000
D[huratinn > 120.000
<~ ( gnits and Formatting... )> 180,000
CLICK Select Column ;.
— —
(oK l) Cancel |
b
J.  Your storm data dialog box should look as shown below:
7] Storm Data M
A-xmB | m| - Stom Evert '“D | Library | Notes | Return Periods l—
550 User Defined IDF Tabls B-X|E-X
: {Elz US;; Dbl hic i) Duration 2Year 10 Year 25 Year 50 Year 100 Year
Hydro- ) {min) (inh) (in/h) {infh) (inh) (in/h)
= :gigab'e Equation 1 0,000 0.000 0.000 0,000 0.000
g IDFPE;:OE_I?;aE:”Equaﬂ 2 10.000 0.000 0.000 0.000 0.000 0.000
=) UK Standard g 3 15,000 0.000 0.000 0.000 0.000 0.000
4 30,000 0.000 0.000 0.000 0.000 0.000
g 5 60,000 0,000 0.00 0.000 0,000 0,000
Project Specific IDF Table 6 120,000 0,000 0.00) 0.000 0,000 0,000
7 180,000 0.000 0.0 0.000 0.000 0.000
Durations
Enter data from PF tabular format of the NOAA
Atlas 14 Point Precipitation Frequency Estimates
User Defined IDF Table - Hartford
= 1.000
=
=
B
B
= 0.000
25.000 50.000 75.000 100.000  125.000  150.000  175.000
Duration (min)
=  2Year = 10 Year = 25Year = 50Year 100 Year I
[ Close l [ Help l
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K. Enter into each column (year —in/hr) the data from NOAA Atlas 14 Point Precipitation
Frequency Estimates for your project.
L. The User Defined IDF Table should look similar as shown below:

PaN PAWAVAWAN PAWAWAN
™% Stomn Evert Input | Library I Notes
(@~ xlE-X
Duration 2Year 10 Year 25 Year 50 Year 100 Year -

{ (min) (infh) (infh) (infh) (in/h) (in/h)
4 1 5.000 <.860 7.420 9.010 10,200 11.500

2 10.000 3.440 5.260 6.380 7.250 §.130 =
43 15.000 2.700 4.120 5.010 5.690 6.380
{4 30,000 1.820 2.780 3.380 3.850 4.310
45 60,000 1.140 1.750 2.130 2.420 2,720
ﬂ’ﬁ 120.000 0.738 1.120 1.360 1.550 1.730 sl
4 1250 —— User Defined IDF Table - Hartford
Q0 mamf e ——
é B O T bt b I
< 8.750 A
§ T 7.500 A\ b e e
g : | | | | | | 1
{ zemo P\ I [ S I
< £ | | | | | | |

2 | | | | | | |

< S 5000 NN N (SRRE—— e ey e e
E 3.750 - i oo S e
é 2500 | | o S, e
E 1.250 = — ' I
< 0.000 - S S VSOOI S —I
< 100.000 125.000 150.000 175.000
< Duration (min)
g = 2 Year = 10Year = 25Year = 50 Year 100 Year I
< Close Help
&

M. After all your input is completed click Close.

N. Again save the project. Click on StormCAD in the MicroStation menu, click on Project 2>
Save Attached As..., in the “Save As” dialog box select the file name for your system and
click “Save”. The message “file name” already exists. Do you want to replace it. Click “Yes”.
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Section 3 Design of Storm Sewer System

3.1 Layout of Storm Sewer System

A. Using the StormCAD Layout tools place your drainage structures and conduits as needed.
You can follow the Quick Start Lessons — Part 2.
B. As Example: Select Catch Basin, as your inlet and place at desired location

iew 1, Default (< default>, Base)

Q- ARIREHY O BIE|HLE

StormCAD Layout i K

ﬁﬁﬁgéﬁfjf

() STORMCAD Layout otz Jecale- o s
R A (T ———

(o

C. Next pick either conduit or channel. Start at the catch basin just placed, within the Layout
Conduit box select your next inlet or outlet (example: catch basin).

Manhole

Manhale
Catch Basin

Cutfall

Pond Qutlet Structure |=
Cross Section

Wet Well

Transition

Pump
CHANGE AS NEEDED l

22
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D. Continue to place the conduit/channel until all of your system is placed ending with Outfall.
You can change the structure using the pull-down menu from the Layout Conduit box.
StormCAD will number everything.

13- 1 \

CB = Catch Basin

CO = Conduit

-

Qutfall always
last in system

1 STORMCAD Layout Cnndu
= /

[Conduit

@
O
©

Catch Basin "‘-\.\
Outfall 1
Pond Outlet Structule
Cross Section
Wet Well
Transttion
~ D || Pump
CB-18 Headwall ==’

23



E. Now place the catchment areas for each inlet (catch basin). You can just draw shapes and

insert the size or you can draw the actual area shape and have StormCAD calculate the

area.

< = i:/B_ 1 For each Catchment

4

9 Y YA YA VAVAVAVE VANVA VA VAV VAVAVAVAVAN

CM-7"

[Shared Celk: catchbasin \ Line

the Outflow Element
needs to be selected

CcMm-7
Cb STA 125+70LT
<Collection: 0 tems>
<Collection: 0 tems>

<Collection: 6 tems>
0.018
False

CB8 o

C = 8 Outflow Element <None>
Inflow (Wet) Collection  [<None>
vV . Rungf

Property Search v P
124

Label C™-7 =
Notes Cb STA 125+70LT
GIS-IDs <Collection: 0 tems>

<Collection: 0 tems>

<Collection: 6 tems>
0.018

Use Scaled Area? False

Area (User Defined) (acre: 0.000

Levek Default

Tosm

OutflowEn nnn g CB-17

Inflow (Wet) Collection <Collection: 0 tems>
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3.2 Input Design Data for Storm Sewer System

F. Using the “Select Tool” double-click on the first catchment area, the properties box will open.
Enter all the data for your SYSTEM, continue with the other items in your system. See most
common examples (Catchment, Catch Basin, Conduit and Outfall)below:

| Properties - Catchment - CM-7 (124)

CM-7 v Q@ 2005 -~
t- ,.g&ww to add to System
<Show All> vl '
Property Search - P -
B <General>
[ 124
Label cm-7 USER C EDIT
Notes == CB STA. 125+70LT
GIS-IDs <Collection: 0 kems> * = User I“put
Hyperlinks <Colection: 0 tems>
B «Geometry>
e ;C”"mm — =2 = StormCAD
Use Scaled Area? == False
Area (User Defined) (acres) == 8 500
e — True = Incl. in Calc's
Is Active? True - '
B Catchment False = Not Incl. in Calc's
Outflow Element == CB-17
B Inflow [Wet)
Inflow (Wet) Collection <«Colaction: 0 tems>
E Runoff
Runoff Method —3> Rational Method
Area Defined By == Single Area
Runoff Coefficient (Rational) == 0.300
Te Input Type wap- User Defined Tc
Time of Concentration (min) == 17.000
Time of Concentrabon (Composite) (min 17.000
E Results
Calculation Messages <Collection: 0 tems>
B Results (Catchment)
stchment f (N/A)
stchment Intensit /A
e m—— N/A)
E Results (Flow)
v (Tolz (N/A)
(N/A)
E Results (System Flow)
Arsal Reduction Factor N/A)

Time of Concentration (Composite) (min)
chnpolaith\raluembmadmlhedmin the Tc Data
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C"CBSTA125+35LT
<Collaction: 0 kems>
<Colsction: () Rems>

120
Label gca-w USER CAN EDIT

835,255.01
738,947.75
(N/A)

m True = Ind. in Calc's
False = Not Ind. in Calc's

Local Pipe Matching Constraints? Faise

Design Structure Elevation? True -

Desired Sump Depth (ft) 200 | USER Input/Selection

Design Inlet Opening?

Specify Local Inlet Constraints?
E Flows

Flow (Additional Subsurface) (cfs)

Flow (Known) (cfs)

Flow (Additional Carryover) (cfs) USER Input/Selection

External CA (acres)

Catalog ket Inlet Libray: ct-inlets.xml
+ Combination Type C Single Grate - Grate Type A - Plain Cub

OnGade  OR In Sag
0.013
0.040

Longitudinal Slope (Inlet) (fUR) *
= Inlet Opening
Grate Length (ff) 30
Curb Opening Length (f) 30
Clogging Factor (%) = 500
E Physical
Update Ground Elevation from Terrain Model? | False
Elevation (Ground) (ft) 34500
Set Rim to Ground Elevation? False
Elevation (Rim) (f) 34483
Elevation (Invert) (ft) 341.33
Structure Type Box Structure
Length (f) 300
Width (f) 300
Gutter Type User Defined
Gutter Shape Conventional
Maximum Gutter Depth (ft) 0.50
Road Cross Slope (ftft) 0.020
Depressed Gutier? False
E Physical (Struchure Losses)

Headloss Method )
HEC-22 Benching Method Fat
El Results

USER Input/Selection

ming N/A)
1D
Unigue identifier assigned to this element.




Note:
“Structure Losses” (Headloss Method) for catch basins (inlets), Figure 7-6, typical bench

configurations from the HEC-22 — Third Edition.

Benching tends to direct flow through the access hole, resulting in a reduction in energy
losses. Figure 7-6 illustrates some typical bench configurations.
ah A A = N e
o 4K 4 H B
a. Depressed b. Flat c. Half Benching
Standard for CTDOT
™) [ ™) ]
d. Full Benching e. Improved
Figure 7-6. Access hole benching methods.
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Active Topology

Is Active?

Design

Design Conduit?

Design Start Invert?
Design Stop Invert?
Specify Local Pipe Constraint?
Diversion

Is Diversion Link?
Physical

Conduit Type

Catalog Class

Size

Section Type

Matenal

Diameter (in

Wall Thickness (in
MNumber of Barrels
Manning's n

Use Local Conduit Descripbon?
Conduit Description

Set Invert to Starl?

mvert (Start) (#

Set Invert to Slop?

mvart (Stop) (ft

Has User Defined Length?

Length (User Defined) (ft)

Length (Unified) (f

Slope (Calculated) (R

Has User Defined Bend Angle?
Bend Angle (Calculated) (degrees

123

cos USER CAN EDIT
STA125+35LTTORT
<Collection: 0 tems>
«Collaction: 0 tems>

<Reverse Start/Stop>
CB-18
o0&

<«Collaction: 2 tems>

True = Ind. in

False = Not Ind

USER Input/

Circle - Concrete
18 inch

Concrete
18.0
e
0.013
False
Circle - 1800in
True

USER Input

The size of the catalog conduit reference to use for this conduit.

28
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Local Pipe Maiching Constrainis?
Design Structure Elevation?
Desired Sump Depth ()

Seal Rim to Ground Elevation?

Elwmmn (Imvert) tﬂ.:l

— 122

06 USER CAN EDI
9. ENDWALL STA. 125+35RT

<Colection: 0 Rems>

<Colection: 0 Rems>

0+00

83528497
738.955.90

True = Ind.
False = Not:

Displays the ground elevation for the currently highlighted node.

29
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Section 4 Analyzing the System

Before you can analyze the system you created you have to select Global Storm Event for your
calculations.

4.1 Global Storm Event

A. Select Global Storm Events... from the StormCAD Components & Tools.

L i e e Y Y Yo Yo Yo e e e
= StormCAD Components & Tools BEEE A
Ea, Q| Attach BExisting 3
[ W Calculation Options »
[&] E Element Symbology »
@ R Compute Center 3
;‘h_ T Active Topology Selection 3
|49 A Global Storm Events... '

4) 1 Default Design Constraints..,

[E S Scenario Summary

=]

%% D|Check for SELECT Updates | 41 el BEEe

]

Global Storm Events...

N ANANNANANANNAIAEAIG AN AN

B. In the Global Storm Events box, click on ¥ (down arrow) and select the Global Storm

Event needed for your calculation scenario. Click Close.

1 Global Storm Events ﬁ
Alternative Global Starm Event Source REE;HEFSSEM
12: BaseRainfall Runoff |Base Rainfall Runoff | User Defined IDF Table - Hartford - 10 Year = |_... || Orphan (local) 10
- User Defined IDF Table - Hartford - 2 Year

Pick Storm * User Defined IDF Table - Hartford - 10 Year

Event needed User Defined IDF Table - Hartford - 25 Year
User Defined IDF Table - Hartford - 50 Year
User Defined IDF Table - Hartford - 100 Year ’ Close ] ’ Help l
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4.2 Validate and Calculate the Model/System

A. To analyze the system created, select Compute Center = Validate. You may get a
message for errors or warning. Click OK.

W Scenarios 3 . )
Bentley StormCAD Vi [SELECTseries 3) (5™
(@] E Element Symbology 3
| One or more validation errors or warmings w

Compute I gs were found, Please refer to
E . @ 1 ¢ the User Maotification panel for validation messages,
1 Compute Center -
iy T Active Topolg

2 Compute
4" A Default Desig
i v 3 Validat S‘

& S Scenario Sun ™2 = sieere e
&' o, 4 alpylat)

B. User Notifications may open displaying a list of warnings generated during the validation.
There are two types:

° 0 Red => error must be corrected before model (system) can be computed,

° Yellow => does not prevent successful calculation of model (system).
As Example:

User Notification:

m User Noation \ |

TR

Messa enario Element Type Label Time {min) Message Source
o i Secalts il structure Loss Mode st be st to order to use the 22 Enerng d Editio sadloss Method
@ 44125 Base CatchBasn CB9 (

044125 Base Catch Basin  CB-10 (N/A)  The calculation option Structure Loss Mode must be set to EGL in order to use the HEC-22 Energy (Third Edition) Headloss Method.  Hydraulic Results

< 1 +
—

Meaning: Inlet calculations use the Headloss Method: HEC-22 Energy (3rd Edition) to use this, the
Structure Loss mode must be set the Energy Grade Line in the calculation options.

Road Cross Slope (ftift) 0.020
Depressed Gutter? False
E Physical (Stucture Losses)

Headloss Method HEC-22 Energy (Third Edition)
HEC-22 Benching Method
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Fix / Change: Click on Calculations Options in the StormCAD Components & Tools task bar.

[£5 StormCADComponents & Tools ux

G Q Attach New

1 Scenarios
(@ E Element Symbology
@ R Compute Center Iﬁ S
,a[:&  Aciive Toologw Selecti B 3 Calculation Options
& ve [opology 1on
4 A Engineering Libraries... = Open 'StormCAD Scenario’ as Toolbox

[Z S Scenario Summary 3

0| Check for SELECT Updates

In the Calculation Options box right-click on Base Calculation Options and click Properties. In the
Properties — Solver — Base Calculation Options box change the Structure Loss Mode from Hydraulic
Grade to Energy Grade. Close the boxes and Validate again.

Properties - Sclver - Base Calculation Options (27) | = P |
-2 - Jig T -
[ Calculation Options ] 9 - | [# Add to Selection
Ax By mle / y
v Al
EI{E] Solver
g~ ] Base Calculation Options ity Search - P~
Rename 37 i
T =] Base Calculation Options L

=]
lihve Numerical Solver GVF-Rational (StarmCAD)
lculation Type Analysis

Minimum Time of Concentration (min) 5000

B Gravity Hydraulics

Maximum Network Traversals 5

Flow Convergence Test 0.001

Flow Profile Method Baclkwater Analysis

Mumber of Flow Profile Steps 5

Hydraulic Grade Convergence Test (ft) 0.00

HAwerage Velocity Method Actual Uniform Flow Velocity

Minimum Structure Headloss (ft) 0.00

m

Governing Upstream Pipe Selection Method Pipe with Maodmum GV

Structure Loss Mode Energy Grade change to
Include Conduit Flow Travel Time in Desigr
Save Detailed Headloss Data? Hydraulic Grade

Gravity Friction Method Manning's
|Uze Explicit Depth and Slope Equations?  False
|gnore Travel Time in Carrier Pipes? False
AVACACVEVAS AT AVAVAV A AVAVAVAVAVAVAVAVAN
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User Notification:

= e e PN
Source

Message Id Scenario  Element Type  Hementld Label Time {min) Message _
) Base  Condui B CO10 Conduit does not meet minimum cover constraint. I"E“"aﬁ"”

Meaning: The culvert (pipe) doesn’t have enough cover as set in the Default Design Constraints.

Fix / Change: Pick a smaller culvert size and add extra barrel if needed, or lower the culvert
elevations as needed, or leave as is and make culvert a Class V concrete culvert. Close the boxes
and Validate again.

T 15 DIVErsion UnK 7 Faise
B Physical > © Physical

Conduit Type Catalog Conduit BEPS "MLIZPC Catalog Condutt

Catalog Class 133: Grcle . Conertle > Catalog Class~~~_ 133: Circle - Concrete

Size 18inch “[|@ Results (Profile Summary) Sie A 12inch g *

Sectio pe W E Results (Profile) Section Type Cide_“El Results (Profile)

3tena Concrete Depth (In) (1t 995 Concrete Depth (In) (ft 995

18.0 120

i s 5o

SAVEr TSYARYTRY
ar (Minimim) (#

& Results (System Flow)

Bentley StormCAD V8i (SELECTserie... (B2

@ Mo validation issues found,
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C. After you validated and all issues (RED) have been resolved as needed for your design
system click the Compute button to calculate the model (system). After the calculation is
complete, the GVF-Rational Calculation Summary is displayed. Review the Messages...,
Details ... and Close. Make any changes necessary, validate and compute again to update
your design.

rag GVF-Rational Calculation Surnmary ﬁ1
Scenario
Label: Base
Storm Event
Rainfall Alternative Label: Base Rainfall Runoff
Global Storm Event: User Defined IDF Table - Hartford - 10 Year
Return Event: 10 YEGrs

Calculation BExecutive Summary

=x> Info: Subsurface Metwork Root: O-5
=32 Info: Subsurface Analysis iterations: 1
=3 Info: Convergence was achieved.

WOWON

Messages..| | Feport || Detais.. || Cose || Hep |
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4.3 Presentation of Results

After all the calculations are completed the designer needs to be able to display and print the
information, StormCAD uses reports, flex tables and profiles to display and print the drainage
model calculations. We discuss FlexTables and Profiles, users are encouraged to explore the
presentation options more on their own.

4.3.1 FlexTables

Different FlexTables are available for a drainage system as needed. The designer should use the
drainage manual as a guide to determine the information needed to represent the designed
system, example: CTDOT Drainage Manual - Tables 11-4 & 11-5 Inlet Spacing Computation Sheet
and Tables 11-8 & 11-9 Storm Drain Computation Sheet.

A. To view flex tables, from the menu bar select StormCAD = View = FlexTables or use the
StormCAD Components and Tools task, left-click and hold on Element Symbology 2>

FlexTables.

Sation VBi (SELECTseries 3) P A NARMAANANANVVNVNA
Utiities Workspace Window | StormCAD = Help & $tormcan; Componant ... BB, o :
v 'Default v? E Project 4 l ; 0 v Q 0 v) R~ ches R d s
X : - Edit » & W Scenarios » s

W View 1, Default (<defal analysis » [3) € Element Symbology e <
TR v@ v AR ;‘_goln?onenls (N (8 R! Compute Center T o Eemen miology $
| View » @ Element Symbology O R} i TlActive Topology Seled B 2 Viw Associenons S
Tools » 3 View Associations 1 Al Stomn Deta 2l 3 Network Navigator S

= ‘
Beport % il Network Navigator &1 S Scenario Summary S5 4 Selection Sets s
v Hel, >, . .
Help [&] Selection Sets % Dl Checkfor SELECTU] % 3 Queries 4
M 2 y
% Queries ) 4§ Prototypes \
v % Proto & Print Preparation i s

%) Ul ‘VPOS

‘ 0 7 FlexTables kS
:ltFIexTablss —B : ‘ = & Profiles » S
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B. The FlexTables dialog box opens. Custom CTDOT Tables are available for catchment, catch
basin, conduit, manhole, gutter and outfall. The designer can also create tables or modify

tables. Multiple tables are stored and can be accessed by clicking on the checkbox for
Tables — Predefined.

-

"] FlexTables = =]

b-Xm #F@A-2 @

=] Tables - Project
S C TDOT Catchment Table

- @ CTDOT Catch Basin Table

-+ & CTDOT Conduit Table | l
- @ CTDOT Manhole Table CT DOT TABLES
- @ CTDOT Gutter Table

“ CTDOT Ouffall Table

Tables - Shared
7] Tables - Predefined

C. The designer should determine if all information needed is available. Individual flextables
can be modified by Right-Click = Edit to add and/or remove selected columns.

21 FrxTatie (1007 Carcrmert Tavie YOUR PROJECT & SYSTEM NUMBER | =@ %
S a-B|z|A|@-|@- -
Area (User Runaff Catchment Time of Catchment | Catchment
Labet | Ot fotes Defired) | Coeffcent €A Concentmton imensty  Ratonal Flow
St fares) | (Rawora) | facres) ) (cts)
_D FlexTable: CTDOT Catch Basin Tatle YOUR PROJECT & SYSTEM NUMBER l
" Sla-g|z|rla-| AT
b | e o
= I P Wm“m“'wm E:;x" ﬂ"“’““; o Length With e ’ e e Trew |
7 1] o {Inwwert Captuned] ]
4d-XA|¥0-2 e loaten) "y’ | Ten | ) | ey O Pom | Tl | me WO R
= [T] Tables - Project Ly | 89 [J697] (= gy | W ¢
- i) T T FlexTabhe: CTROT Condduit Table YOUR PROJECT & SYSTEM NUMBER [
crolEEE Pla-a|s|s|a-Ta-n-
5 CTD Open on Selection
CTD qan | Ien Vet | Cgger | SO0 | pameter annng's MO | oy ssocty| 09T jpa
cto|  New ' b | WAS | poge | IS0 | pode | (D | petneg | (C30RE) n LS o) pow)
L) Tables | Delete L] o ] L ey ® ()
H1T] Tables - R -
ename ] Fetlsie CT00T Martie Tske YOUR PROJECT & SYSTEM NUMBER |
Edit. Gla-0|& A 0T
EJ ? Wydeouic | fpdrauic
= Eirvation | Elevation Bevation | Eevation | Fiow(Total = Depth
Dupli % bd | ots | (Gowd) | () | BN et gneetou) | ou) (out) {""c’;‘]""‘ (":'g:;'“;“ ]
m m ’ ) ® (et5) )
[} ]
00 Fiexapie: CTDOT Gutter Table YOUR PROJECT & SYSTEM NUMBER l =
Pl a-a| &, 0
Lemath Sope . mghtsde ||
Lt Nt | sathose | StpMode | (scke) | (Catumes) | "COS" Gumershape | Sope
L (ft} {f#t) {Hv)
[en
, ] P CT00T 0wt T YOUR PROJECT & SYSTEM NUMBER | ] |
F a-g|F A TE TR
Brvaton | Bevaton | Boundwy | Hysewk | EnegyGade | Fow (Toml
Label Motes [Ground) {iwet) | Condion Grade Line out)
[1i4] L1} Type %) () (cts)

D. To view flextables and print click on the Report icon
columns as needed and print to pdf.

, in the preview window adjust
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4.3.2 Profiles

Two types of profiles are available to the designer to show the storm drainage system. The
designer should use the drainage manual as a guide to determine the information needed to
represent the designed system, example: CTDOT Drainage Manual — Chapter 11 — Figure 11-12
Use Of Energy Losses In Developing A Strom Drain System.

Conditions: Q1=Qz=0s
Vi=Vz=Va
S1pSaySa HEAD LOSS AT Proposed Grade
JUNCTION NO. 2 o et
HEAD LOSS AT '

JUNCTION NO, 1

NOTE: By mcreasing the size of pipes 2 and 3
the friction slope was réduced such
that the HGL doas not excoed the
top of Jet. 2 and Jet. 3,

<
<
<
<
%
<
<
<
<

Figure 11-12 Use Of Energy Losses In Developing a Storm Drain System

A. To view profiles, from the menu bar select StormCAD = View > Profiles or use the
StormCAD Components and Tools task, left-click and hold on Element Symbology 2>

Profiles.
tol ‘-- D ! t -
| : 3 stormCAD Component...
- L= P :
= = Edi 3
B View 1, Default (<defat  Analysis DéSceﬂanos
1B~ ARK]E com ts 1V E FlexTobles ‘
g ‘-pronen » @ Element Symbology @R 2 @ 1 Element Symbolog
Tools » @ View Associations OR % j Active T S @ 2 View Associations
E:pon :2] NNetwork Navigator 4 A|Defout Design Const{ 2 3 Network Navigato
T &1 Selection Sets &S ScenaiioSummery | 8| 4 Selection Sets
Queries o
Eer=a0 ; ;m" "3 D Check for SELECTU{ % 5 Queries
& r_o(ypes -
O FlexTables {2 print Preparation i & Prototypes
al
= O 7 FlexTables
= 8 Profiles
NANNANANAN NV A
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B. The Profiles box opens, click on the “New” icon ‘ and click New. The Profile Setup box
opens. Click on Select From Drawing. The STORMCAD Elements ProfileSelection pick box
opens. Select the structure items in your system to show as profile.

[ Profiles
INGECIL & B r
Amocbl’r Jes..
User 5
Label ‘ Defined ‘ S‘E{‘)""
| Station
1 B8 | B 0+00 |
Profile Setup 2 co10 | B A)|
: 3 B9 0 | 0+18
tabel | Doy | Station 4 co-11 [ B8 ] oA |
Staﬁon‘ ® 5 |ce-10 | B | 1+14 |
6 |co12 | 8 | WA l\
‘u~: S—— 1437

'E R LR —
Select Open Profile
OR

|

Open Engineering Profile

[\ s1omcm’sremems ProﬁleSelecﬁonﬂl l/

Click when DONE

C. Select the profile option you want: Open Profile or Open Engineering Profile. The profile

box will open, both boxes have various options to label, annotate and print the profile
display.

(et ropt s o .| e N v . e et o
Cpr  |[aviaraaras vew
(3:X0 240000 o

2000 ‘
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VY Ol Rm 75208
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¥ R 249! ob
£A Coted Bas Mvottsbin CB8 | lvet Z000% / o MO0
r el / | vt 20200
/ |
[

9 ¢ Tosdon e /
Ivrtin (1) 29200 2 (NAV R
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Eevanon )

B
e
= -
=
£

mu

9 e

y
§ 38
i

00 WS N N0 M0 W) @) MO WA WO Jed IR0 N6 DM

o] M@w e ]
(i 8| e s 18
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) " ::‘ ) BTy e T
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XNOBNY 2520 WIsN
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Section 5 Convert/Opening Existing StormCAD
Project

Should you need to open an existing StormCAD project please follow these directions. File
extensions for StormCAD V8i SS3 have changed from previous versions. New files have to be

created.

A. Create a new *.dgn file using the HaestadSeed2d.dgn file, see Section 1.1.2 .
B. Select from the menu bar StormCAD - Project = Import 2 StormCAD Database

@icrﬂStatiDn W8i (SELECT=eries 3)

e Window | StomCAD | Help

,\Q vﬁ]l Project b [y Atach New.. v] |:| 0 - ; 0 <

Edit ¥ [u, Attach Bwisting...
B Viewl, Analysis ¥ () Save Attached As...

3
Eé &) Components =¥ Detach... rﬂ (&
T View » =

Tools v Import »{C StormCAD Database... )

Beport 3 Export ¥ Submodels...

Help [ Seed > LandXML...

InRoads...

Save Symbology to DGMN

Bentley MX Drainage (Land¥ML format)...

C. Inthe manager select the existing Prj_Nbr_Sys_XX.stc.mdb file. Click Open. Please be
aware if the existing model/system is large it can take some time. Click Yes. Files with new

extensions will be created by StormCAD V8i SS3.
D. The following question may come up: Do you wish to synchronize the drawing now? Click

Yes.

Bentley StormCAD V8i (SELECTseries 3) | J

@C% Synchronizing the drawing will add, rermove, and update elements to
"' match the database.
Do you wish to synchronize the drawing now?

QC v D[ e
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E. The Save As box opens. Save the file into the project container. You will see the *.stsw file

extension.

m Save As | 2 |
@H\:/’I'| | < Highways » _Eng_Data » Drainage - | +y | | Search Drainage p|
Organize « Mew folder == - .@.

L Intersection Magic (M:) *  Name . Date modif
5@ DGES HWYS (DOT-SDCEMNGOLY) (P:) o
|&| StormCAD_ 1234 1234 Sys-01.stsw 6,/4/2015 &:
& GROUPS (W SDCDBS60) (5:)
# DGES CTDOT_Projects (SH3DG518) (X
'?j Metwork
&l [ 1] 3
File name: HW_MST_ 1234 1234 StormCAD_Sys-03.stow -
Save as type: | Bentley StormCAD Vi I[S-ELECTseriq; Project File (*.stsw] —3 v]
+ Hide Folders [ Save ] [ Cancel ]

F. StormCAD recreates the schematic in the new DGN-file and creates all the files needed
with new extensions. After completion of the import you can make changes as needed,
such as updating the rainfall intensity with a new User Defined IDF-table, see Section 3.
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